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Introduction to the TI Connect™ CE Software

The Tl Connect™ CE software makes exchanging information between your
graphing calculator and your computer quick and easy.
The Tl Connect™ CE software includes three workspaces:

Calculator Explorer: allows you to manage calculator content
Screen Capture: allows you to manage screenshots

Program Editor: allows you to work with data variables
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Using the Tl Connect™ CE Software Window

The Tl Connect™ CE software window contains tools you can use to exchange
information between your calculator and your computer.

= Tl Connect CE SRIc X

CONNECTED CALCULATORS (1) Archive: 2,837 kB available | RAM: 154 kB available
,
% B . NAME Tvee suze LocaTion
0550 [E4] image1 Background Image 22 kB Archive
553_" 1 [ 1mage2 Background Image 2248 Archive
CAPTURE [Ed] image3 Background Image 22 kB Archive
1 [ imaged Background Image 218 Archive
T [E] images Background Image 22k8 Archive
EROSAAN. 1 Real List 28 RAM
) L Real List 2B RAM
1 [ N Real List 28 RAM
G0 Real List 2B RAM
1 [ Real List 28 RAM
) L Real List 2B RAM
1 @ Flysmi2 Flash Application 64 kB Archive
@ Inequalz Flash Application 43k8 Archive
| [0 svenska Flash Application 43 kB Archive
[0 Nederlan Flash Application 43kB Archive
| [0 Deutsch Flash Application 428 Archive
D Francais Flash Application 47 kB Archive
| LN Thiser Table Setup 208 RAM
1N Window Window 2108 RAM
| LN ReWindw User Zoom Recall Window 209 B RAM

(3] 4] (5]

Parts of the Tl Connect™ CE Software Window

o Menu Bar - Use these menus to manage files and images, to view
calculator information and to get help.

Note: You can complete most of the actions in these menus by dragging
and dropping files from the content panel to your calculator or computer.

9 Toolbar - Use these icons to manage files and images.

9 Workspace Panel - Use this panel to navigate workspaces (Calculator
Explorer, Screen Capture, and Program Editor).
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o Calculator List Panel - Use this list to view all connected calculators and to
select one calculator to display in the content panel.

9 Content Panel - Use this panel to view and manage the images and files
on a connected calculator.
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Using the Calculator Explorer Workspace

The Calculator Explorer workspace allows you to manage calculator content.

,

TI Connect CE

Help

[

CONNECTED CALCULATORS (1) Archive: 2,837 kB available | RAM: 154 kB available
% Unknown Device - 1327 1 NAME TYPE SIZE LOCATION
0550 4] Imagel Background Image 22 kB Archive
sz“ i 1 [Ed] magez Background Image 22 kB Archive
CAPTURE [Z4] Image3 Background Image 22 kB Archive
1 Ed] Imagea Background Image 22 kB Archive
= =d] Images Background Image 22 k8 Archive
ngﬁ_l::m 1 -} u Real List 28 RAM
{7} L Real List 28 RAM
1 [ I Real List 28 RAM
{3} u Real List 28 RAM
1 {} Real List 28 RAM
{} L Real List 2B RAM
| [ Plysmi2 Flash Application 64 kB Archive
[T Inequalz Flash Application 43 kB Archive
1 [ svenska Flash Application 43 kB Archive
[T Nederlan Flash Application 43 kB Archive
1 [Z] Deutsch Flash Application 42 kB Archive
[ Francais Flash Application 47 kB Archive
1 1N ThiSet Table Setup 208 RAM
Window Window 2108 RAM
1 1..N RclWindw User Zoom Recall Window 209 B RAM

4 Using the Calculator Explorer Workspace




Parts of the Calculator Explorer Main Window

Menu Bar - Use these menus to manage files and images, to view calculator
information and to get help.

File Edit View Actions Help

Note: You can complete most of the actions in these menus by dragging and
dropping files from the Content Panel to your calculator or computer.

Toolbar - Click these icons to add, transfer or delete files from your calculator.

@ Add content from your computer.

@ Send selected content to your computer.
€ Send selected content to another connected calculator.
@) Delete the selected file.

@ Refresh the view of a connected calculator's contents.

Content Panel - Select files you want to manage from this panel.

Selecting a Connected Calculator

The Tl Connect™ CE software allows you to simultaneously connect multiple
calculators. Click on the calculator you want to work with to select it. The
selected calculator becomes the default calculator for all TI Connect™ CE
software actions.

Before you Begin

Connect the calculator to the computer and make sure itappears in the
Content Panel.
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Copying Calculator Files to the Computer

You can copy most data, files and programs from your calculator to your
computer as a content backup, to send to others or to free up calculator
memory.

To copy a file from the calculator to the computer
1. Click on the file name to selectit.

2. Drag and drop the file into a folder on your computer or onto your desktop.

Warning: Do not disconnect the cable during a transfer.

To copy a file from the computer to the calculator
1. Navigate to the desired file on your computer.

2. Drag the file to the Calculator List Panel and hover over the desired
calculator.

3. Release the mouse button when you see F COPY |

4. Select a file name from the drop-down menu. This will be the name of the
image on your calculator.

5. Click Send.

Sending Files to Connected Calculators
You can send files to calculators connected to TI Connect™ CE software.

Warning: Do not disconnect the cable during a transfer.

To send files to connected calculators
1. Click the file to selectit.

2. Click.
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~~ Send to Calculators = X l

DESTINATION CALCULATORS:

®) All Connected Calculators _ Select Calculators

| Replace existing content with the same name on destination calculators

Cancel Send

* DESTINATION CALCULATORS: Select whether you want to send the file to
all connected calculators or just selected calculators (from a check list).

To send files to select calculators
1. Select the Select Calculators button in the dialogue box.

2. Check the boxes next to the calculators you want to select.

3. Click Send.

Deleting Calculator Files

You can delete data, files and programs from your calculator.

To delete files from the calculator
1. Click on the file name to select it.

2. Press .
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Using the Screen Capture Workspace

The Screen Capture workspace allows you to manage calculator screenshots.

F2 TI Connect CE == &

File Edit View

D CONNECTED CALCUL... (1)
CALCULATOR
EXPLORER 1

@ Unknown D... -1327 (O]

0550

u
=
PROGRAM
EDITOR

Parts of the Screen Capture Window

Menu Bar - Use these menus to manage files and images, to view calculator
information and to get help.

File Edit View Actions Help

Note: You can complete most of the actions in these menus by dragging and
dropping files from the content panel to your calculator or computer.

Toolbar - Click these icons to save, send, copy, delete, edit and store files.
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@) Save afile to the computer.

@ Send afile to a calculator.

€ Copy afile.

O Delete afile.

@ Add or remove a border from all screenshots
(D Change the size of all screenshots.

@ View the screenshot size.

Content Panel - View screenshots in the content panel.

*Capture 1 X

NORMAL FLOAT AUTO REAL RADIAN MP n

Capturing and Using Images
In the Screen Capture workspace, you can capture screens from your

calculator and view them as images.

Before you Begin

Connect the calculator to the computer and make sure it appears in the
Content Panel.
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To Capture Calculator Screens

1. On the Tl Connect™ CE software Workspace Panel, click the Screen
Capture workspace.

2. Display the screen on your calculator that you want to capture.

3. Click @ next to the desired calculator in the Calculator List.

Saving Images as Files

The Screen Capture workspace lets you save captured or existing images from
your calculator. You can save images to your connected calculator as a PNG.

*Capture 1 b
MORMAL FLOAT AUTO REAL RADIAN HP n
|

Note: The asterisk at the beginning of an image name indicates that the image
is not saved.

To save an existing image
1. Click the image.

2. click El.

To save multiple images
1. Click Edit > Select All.

2. click Bl
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To rename a screenshot

1. Place your cursor at the beginning of the image name field.
E.g.: Capture 1.

2. Double-click the name to selectit.

3. Type in a new image name.

To save a hew screenshot as a PNG file
1. Click the image.

click .
Navigate to the location where you want to save the file.

2
3
4. Use the default file name or type a new file name.
5. click Bl

Sending Images to Connected Calculators

You can send images to your connected calculator. Do not send flipped,
rotated, or resized images, as they become distorted when you try to view them
on a calculator.

Warning: Do not disconnect the cable during a transfer.

To send screenshots to connected calculators
1. Ifyou have not already done so, capture the screen.

2. Click the screenshot to selectiit.

3. CIick.
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= Send to Calculators = R

FILE NAME: NAME ON CALCULATOR: LOCATION: =

Capture 1 Imagel i \/

_| Graph Area Only

Screen captures and converted image files will be sent as Pic Vars to black and white
calculators

DESTINATION CALCULATORS:
® All Connected Calculators o Select Calculators

|| Replace existing content with the same name on destination calculators

Cancel Send

*  FILE NAME: This may differ from the NAME ON CALCULATOR depending
on what you named the screenshot on your computer.

*  NAME ON CALCULATOR: select the background image (it should be the
default but you may change the background image name using this
menu).

*  GRAPH AREA ONLY: On the right-hand panel, select whether you want to
send just the graph area or the entire screen. When sending a screenshot
back to a calculator, it is best to send the graph area only.

+ DESTINATION CALCULATORS: Select whether you want to send the
image to all connected calculators or just selected calculators (from a
check list).

Note: Screenshots and converted image files will be sent as pic vars to
black and white calculators.

To send files to multiple calculators
1. Select the Select Calculators button on the dialogue box.

2. Check the boxes to next to the calculators you want to select.
3. Click Send.
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Sending Screenshots to Computer Applications

Using the Screen Capture workspace, you can drag and drop captured images
into many computer applications. This feature lets you use calculator images in
your documents.

To drag and drop images into computer applications
1.  Open or capture the image.

2. Drag and drop the image to an open document or presentation software
application.

Converting and Sending Background Images

The TI-84 Plus CE can display background images and pic vars. These
variables are displayed in the graph area.

Note: All information about background images also applies to the TI-84 Plus C
Silver Edition and the TI-83 Premium CE.

Working with Background Images

The Tl Connect™ CE software automatically converts any image you send to a
connected calculator into a background image. Your image may not display in
the graph area as you expect, given the conversion to the 83 x 133 pixel
dimensions. The conversion to the background image uses 16-bit colour.

You can also upload a background image into the TI-84 Plus CE emulator view
in TI-SmartView™ software.

On the TI-84 Plus CE, a background image displays as the background in the
graph area only. A background image will appear scaled for the MODE screen
settings of Full, Horizontal, and Graph-Table. This preserves any mathematical
modelling done on a background. You cannot edit a background image while
working on the TI-84 Plus CE. Background images run from and are stored in
the archive memory.

Cropping an Image
A screenshot of the graph area includes the full screen of the TI-84 Plus CE,
the status bar, the graph border and the graph area.
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TI Connect™ CE software allows you to crop the image to a Graph Area Only
size to create a background image. You can crop an image in the Send to
Calculators dialogue box.

W7

WA | B

.| Graph Area Only

Working with Pic Vars

You can create and modify pic vars. Pic vars display from the upper-left-hand
corner of the graph area and do not scale for the MODE screen settings: Full,
Horizontal, and Graph-Table. You can open and view pic vars in the Screen
Capture workspace. You can save them as computer files with the file
extension *.8ci.

Pic vars run from and are stored in RAM memory but they can be stored in
Archive memory. This difference is important when clearing RAM.

Note: Tl Connect™ CE software will not convert a pic var (*.8ci) to a background
image (*.8ca).
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Sending a Background Image to a Connected Calculator

You can send a background image and display it in the graph area of the TI-84
Plus CE.

o g A~ w N

N

Open the Tl Connect™ CE software.

Choose the Calculator Explorer workspace.

Connect the TI-84 Plus CE to the computer using the cable.
Turn on the TI-84 Plus CE.

Choose the image you want to convert.

Drag the picture to the Calculator List Panel and hover over the desired
calculator.

Release the mouse button when you see % Copy

Select an Image# name from the drop-down menu (Image0 - Image9). This
will be the name of the image on the TI-84 Plus CE.

Note: The Image# name you choose becomes the image name on your
calculator. Note this Image# name (or make it part of the file name on your
computer) for identification purposes when you want to send or share this
file.

Click Send.

To save the background image to your computer, drag the Image# from the
Calculator Explorer to your desktop or to the folder where you want to save
it.
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To display your new background image in the graph area of the
TI-84 Plus CE, press [FORMAT], change the Background setting to the
Image# you just sent to the calculator (example: Image5), and press

GRAPH|.

NORMAL FLOAT AUTD REAL RADIAN HP n
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Using the Program Editor Workspace

The Program Editor Workspace allows you to work with data variables.

SCREEN
CAPTURE

@)

CALCULATOR
EXPLORER

MNew Program

_|_

Open Program

|
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Parts of the Program Editor Workspace

Menu Bar - Use these menus to manage files and programs and to get help.

File Edit View Actions Help

Note: You can complete most of the actions in these menus by dragging and
dropping files from the content panel to your calculator or computer.

Toolbar - Click these icons to add, open, and save programs and to send
programs to your calculator.

+ =

Content Panel - Use this panel to create, view and edit programs.

Catalogue Panel - Use this panel to select your calculator type and then choose
from lists (by category) to create programs.

Syntax Reference Panel - Use this panel to view the proper syntax of each
command, together with required and optional arguments.
Creating a New Program

When no programs are open the Content Panel displays only the new program
and open program icons.

New Program

To create a new program

» Click the New Program icon. -I—
To open an existing program
1. Click the Open Program icon. -—‘
2. Navigate to the appropriate folder. -

3. Click Open.
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Editing a var name

New program names are PROG##. The numbers run in sequence, e.g.:
PROGO01, PROGO02.

To change the program name
» Click inside the Var Name box and type in a new name.

VAR NAME: PROGO1

Protecting Your Program

TI Connect™ CE software allows you to protect your program from being edited
after the program is sent to a connected calculator.

To protect your program
» Click the check box next to the lock icon.

&

Saving a Program to Your Computer

The asterisk at the beginning of a program name indicates that the program is
not saved.

To save a program

1. Click.

2. Navigate to the appropriate folder.
3. Click Save.

Closing a Program

To close a program
» Click the x by the program name.
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Using the Catalogue Panel

The catalogue panel contains a list of calculator commands, functions,
variables and symbols that you can use to create programs.

To expand or collapse a catalogue level
» Click the triangle beside each catalogue entry.

» Angle
» Catalog VAR NAME:  PROGD7
» Char
» Distribution
S @@1  »Frac
» Format
» List
¥ Math

¥ Math

fMin|(
THax |
nDeriv(
fnlnt(
I
T1ogBASE (
solve(

» Numeric

» Complex

» Probability

» Matrix

To place a catalogue entry in the content panel

» Drag and drop the catalogue entry into the content panel.

-OR-

» Double-click the catalogue entry.

Note: Either of the above will place the catalogue entry after the cursor.
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Using the Syntax Reference Panel

The syntax reference panel displays the syntax of each catalogue entry,
including required and optional arguments.

Sending a Program to a Calculator

You can send a program to a connected calculator.

To send a program to a connected calculator

1.

2.

If you have not already done so, save the program.

Click .

FILE NAME: This may differ from the NAME ON CALCULATOR, depending
on what you named the program on your computer.

NAME ON CALCULATOR: select the program name (it should be the
default but you may change the program name by clicking Custom).
= Name on Calculator |i‘-i’—hj

Custom Program names can be up ta 8 characters in length
The first character can be A-Z or 8.
The remaining characters can be A-Z, 6 or 0-8.

CANCEL

LOCATION: Choose whether you save the program in the calculator's RAM
or archive.

DESTINATION CALCULATORS: Select whether you want to send the
program to all connected calculators or just selected calculators (from a
check list).

To send programs to multiple calculators

1.
2,
3.

Select the Select Calculators button in the dialogue box.
Check the boxes to next to the calculators you want to select.

Click Send.
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Maintaining Your Calculator

Updating the Calculator Operating System

TI Connect™ CE software lets you download operating systems for graphing
calculators.

Before you begin
*  Backup your calculator files (RAM, archive, and apps).

*  Make sure your calculator is turned on and securely connected to the
computer.

+ Ifyou have multiple calculators connected with USB computer cables,
disconnect all of them except the one you intend to update.

Warning: Do not disconnect the cable during a transfer.

To update graphing calculator operating systems
1. Click Actions > Send OS.

2. Navigate to the OS file on your computer.
3. Click Open.

Getting Calculator Information

TI Connect™ CE software allows you to getinformation about your calculator's
type, product ID, OS version, RAM, archive, language, ROM version and
hardware version.

To view calculator information
» Click View > Calculator Information.
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2 Calculator Information

CALCULATOR TYPE: Unknown Device

1300001327

B (154 kB available)
194 kB (2,837 kB available)
ROM VERSION: 5.0.034¢

HARDWARE VERSION:

(=]

o
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Compatibility with Graphing Calculators

Note: Not all TI-84 Plus CE graphing calculator files are compatible with other
TI-84 Plus family graphing calculator files because of the high resolution of the
colour screen. In general, numeric files (not limited to lists, variables, matrices,
and functions) are shared between these graphing calculators but apps are not
shared between these graphing calculators, even if they have the same title.
When not compatible, the computer file extensions for the TI-84 Plus CE are
different to a similar variable from the TI-84 Plus/TI-84 Plus Silver Edition
graphing calculators.

File Type Link from Link from 84P TI-84 Plus
TI-84t0 TI-84 TI-84 Plus CE  computer CE
Plus CE to TI-84 file type computer
file type
Operating No No 8xu 8cu
System
Apps No No 8xk 8ck
AppVar* Yes Yes 8xv 8xv
Programs - Yes Yes 8xp 8xp
Tl Basic*
Assembly Yes No 8xp 8xp
Programs*
Pictures No No 8xi 8ci
Background N/A No N/A 8ca
Images
Group Files Yes Yes 8xg 8cg
User Zoom Yes Yes 8xz 8xz
String Yes Yes 8xs 8xs
Table Yes Yes 8xt 8xt
Function file Yes Yes 8xy 8xy
GDB* Yes Yes 8xd 8xd
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File Type Link from Link from 84P TI-84 Plus

TI-84t0TI-84  TI-84 Plus CE  computer CE
Plus CE to TI-84 file type computer
file type
List Yes Yes 8xl 8xl
Matrix Yes Yes 8xm 8xm
Number Yes Yes 8xn 8xn
Complex Yes Yes 8xc 8xc
Window Yes Yes 8xw 8xs
Setup
Certificate No No 8xq 8cq
Backup No No 8xb 8cb

* Programs created using commands available only in the latest OS version
will not transfer to graphing calculators with an earlier OS version.

* App vars and programs should be reviewed for use after the transfer between
the TI-84 Plus family graphing calculators. Some app vars may not set up an
app as expected. Some programs will need to be modified due to the
difference in screen resolution and new commands.

** You may receive a version error if you used DOT-THIN line style. Change
the line style to avoid the error.
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Legal Information

Important Information

Texas Instruments makes no warranty, either expressed or implied, including
but not limited to any implied warranties of merchantability and fitness for a
particular purpose, regarding any programs or book materials and makes such
materials available solely on an “as-is” basis.

In no event shall Texas Instruments be liable to anyone for special, collateral,
incidental or consequential damages in connection with or arising out of the
purchase or use of these materials and the sole and exclusive liability of Texas
Instruments, regardless of the form of action, shall not exceed the purchase
price of this product. Moreover, Texas Instruments shall not be liable for any
claim of any kind whatsoever against the use of these materials by any other
party.

This graphing product application (APP) is licensed. See the terms of the
license agreement.

© 2006 - 2014 Texas Instruments Incorporated

Windows, NT, Microsoft, Apple and Macintosh are trademarks of their
respective owners.
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Support and Service
Texas Instruments (Tl) Support and Service

For general information

Email: ti-cares@ti.com

Phone: 1-800-TI-CARES (1-800-842-2737) For US,
Canada, Mexico, Puerto Rico, and Virgin Islands
only

Home page: education.ti.com

For technical questions
Phone: 1-972-917-8324

For product (hardware) service

Customers in the US, Canada, Mexico, Puerto Rico and Virgin Islands:
Always contact Tl Customer Support before returning a product for
service.

All other customers: Refer to the leaflet enclosed with your product
(hardware) or contact your local Tl retailer/distributor.
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